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Abstract 
An intelligent Internet of Things-based manhole monitoring system is presented in this paper with the goal of 

enhancing urban infrastructure maintenance and public safety. Manual inspection is a part of traditional manhole 

monitoring techniques, which is not only time-consuming and ineffective but also dangerous. This procedure is 

automated by the suggested system, which combines wireless communication, real-time data visualization, and a 

sensor-based platform. It makes use of an ESP8266 NodeMCU microcontroller that is interfaced with tilt, 

temperature, humidity, gas, and ultrasonic sensors. Data is sent wirelessly to a desktop application and a mobile 

dashboard based on Blynk using MQTT over Wi-Fi. High levels of robustness, responsiveness, and dependability 

against environmental factors are demonstrated by field tests. Future improvements like solar-powered operations 

and AI-powered predictive maintenance are supported by the system's scalability. 

Keywords— Keywords Manhole Monitoring, IoT, Smart Infrastructure, MQTT, NodeMCU, Environmental 

Sensors, Urban Safety, Sensor Networks 

 

I. Introduction 
Sewer and urban drainage systems are essential to modern cities' functionality, health, and cleanliness. 

The need for dependable and sustainable drainage solutions increases as urban populations rise and infrastructure 

ages. Conventional manhole systems, which depend on manual inspections or citizen reports to identify problems 

like overflows, obstructions, or gas buildups, frequently lack real-time monitoring capabilities. These restrictions 

may result in risks to the public's health, the environment, and high maintenance expenses. 

The need for intelligent infrastructure that can self-monitor and detect anomalies is highlighted by the 

global rise of smart city initiatives. The Internet of Things-based Manhole Monitoring System is one such creative 

solution. By providing constant, real-time monitoring of vital environmental factors inside manholes, this system 

promotes proactive maintenance and increased public safety. The NodeMCU ESP8266 microcontroller powers 

an embedded platform that incorporates a variety of sensor types, including tilt, gas, and water level sensors. 

These sensors send data via MQTT (Message Queuing Telemetry Transport), a lightweight messaging protocol 

that ensures timely and effective data delivery over Wi-Fi networks and is perfect for environments with 

constraints. 

The system offers dual-platform visualization to make user interaction easier: a Blynk web dashboard 

for remote access and a Windows Forms application for local monitoring. These interfaces enable decision-
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makers to react proactively to new problems by providing real-time updates, alert systems, and historical data 

analysis.  

A comprehensive and scalable solution, the Internet of Things-based Manhole Monitoring System is 

appropriate for a number of industries, including industrial zones, smart city planners, municipal corporations, 

and infrastructure management companies. The scope includes deployment of a single unit as well as a network 

of linked monitoring nodes spanning an entire city. 

 

Key Features:  

• Field-Deployable and Sturdy: The system's parts are kept in weatherproof and sturdy enclosures, which ensures 

their long-term dependability in challenging environmental conditions. 

• Autonomous Operation: By gathering data and sending it over a common Wi-Fi network, each monitoring unit 

works independently, eliminating the need for human intervention. 

• Over-The-Air (OTA) Updates: The NodeMCU ESP8266 core processor unit supports OTA updates, which 

allow system upgrades without requiring physical access and guarantee that the system is always up to date 

with the newest security patches and features. 

• Local and Remote Monitoring: A local user interface that displays real-time data in an understandable and 

graphical format was created for the project using Visual Studio's Windows Forms. This application uses color-

coded signals and sound notifications to display alerts and subscribes to MQTT topics for updates. The system 

integrates with the Blynk IoT platform for wider access, enabling users to view real-time data on web browsers 

or mobile devices. 

• Scalability: The system is designed with future scalability in mind. Other sensors, like cameras, vibration 

sensors, or flood detectors, can be added to it. Additionally, it can be incorporated into a centralized cloud-

based dashboard with data logging, analytics, and automated dispatch that can handle data from hundreds of 

nodes. 

 

II. Literature Review 
[1] Proposes a Real-time drainage monitoring advanced significantly with the advent of IoT platforms like Blynk, 

ThingSpeak, and Adafruit IO. These platforms offer a more user-friendly interface and facilitate the simple 

deployment of dashboards that display sensor data. By allowing users to monitor manhole conditions remotely 

from any location, the move to cloud-based monitoring systems sped up emergency response times. 

 

[2] Conventional HTTP-based systems started to give way to more lightweight communication protocols like 

MQTT (Message Queuing Telemetry Transport). MQTT is a more dependable option for real-time monitoring 

since it is lightweight and designed for low-bandwidth situations, which allowed for quicker communication 

between the devices and the server. Alongside these developments, studies also looked into how machine learning 

and artificial intelligence (AI) might be combined for failure prevention and predictive maintenance. 

 

[3] To guarantee low latency communication and effective data transfer, the system uses MQTT, a lightweight 

messaging protocol, over Wi-Fi. MQTT is intended for real-time applications, as opposed to GSM or conventional 

HTTP protocols, guaranteeing that data can be transferred with the least amount of latency. This makes it possible 

to respond to crises like gas leaks or overflows more quickly. 

 

[4] One essential part of the system is the NodeMCU ESP8266 microcontroller. It offers enough processing power 

and Wi-Fi connectivity to process sensor data, carry out logic, and control communication with the central server. 

The ESP8266 is also very energy-efficient, which makes it perfect for field deployment in isolated or subterranean 

areas.  

 

[5] A specially designed Windows Forms application that offers a graphical user interface (GUI) for users to view 

sensor data and receive alerts improves the system's real-time monitoring capabilities.  

 

III. Methodology 
The suggested IoT-based Manhole Monitoring System adds cutting-edge features to improve urban 

drainage management's effectiveness and security. In order to ensure reliable monitoring of crucial parameters 

like water levels, hazardous gases, and manhole cover status, the methodology is organized around a modular 

sensor integration framework, real-time MQTT communication, and dual-platform visualization. This method 

facilitates scalable deployment in smart city infrastructures and enhances responsiveness to environmental 

hazards. 
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Hardware Assembly 

The following components were used: NodeMCU ESP8266, JSN SR-04T ultrasonic sensor (Trigger: 

D5, Echo: D6), MQ-2/MQ-135 gas sensor (A0), KY-017 tilt sensor (D7). 

Components should be housed in an IP65 waterproof enclosure; tilt sensors on lids, place gas sensors 

close to gas-prone areas, and mount ultrasonic sensors above water. 

 

System Design and Workflow 

 
Fig 3.1: System Design 

 

Firmware Development  

Installing the Arduino IDE and adding ESP8266 board support through File > Preferences and Tools > 

Board > Boards Manager will set up firmware development for a NodeMCU. Set up MQTT with the HiveMQ 

broker to publish to topics like /manhole1/waterlevel, and configure Wi-Fi using your SSID and password. Every 

five seconds, read sensors and format data as JSON (e.g., {"gas": 200}). Use ESP.deepSleep(5000000) to 

implement features like auto-reconnect logic, LED indicators, and deep sleep. Choose the appropriate board and 

port under Tools > Board and Tools > Port after connecting the NodeMCU via USB. Lastly, upload the firmware 

to the NodeMCU. 

 

 
 

System Testing 

Test each sensor separately (e.g., tilt by lifting lid, gas with incense, ultrasonic in water). Check the data 

flow from sensor to NodeMCU to MQTT. System testing: Verify UI updates and alerts; replicate field (sealed 

chamber) and lab (container) conditions. Check battery life (~40 hours), reconnect time (~3 seconds), and alert 

latency (<1.5 seconds). 

Mitigations include using antennas for Wi-Fi problems, repositioning the ultrasonic sensor to account 

for reflections, and adjusting the gas sensor thresholds for false positives. 
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Maintainance and Safety 

Maintenance includes monthly hardware inspections, firmware updates via OTA, sensor cleaning with 

alcohol swabs, and battery recharges every 40–48 hours. 

Safety tips include using protective gear, avoiding submersion, installing away from high-voltage 

equipment, and turning off the power while performing maintenance. 

 

IV. Results And Discussion 
Analysis of the IoT-based Manhole Monitoring System's test findings showed that it met the main design 

objectives for accuracy, responsiveness, reliability, and efficiency while operating reliably under a range of 

operational situations. 

First, a key component of the assessment was sensor accuracy. When compared to calibrated reference 

devices, all of the integrated sensors—ultrasonic, gas, tilt, and temperature/humidity—showed excellent 

precision, keeping accuracy below a 5% range. This degree of precision attests to the sensors' dependability and 

ability to deliver dependable data for practical use. In vital monitoring systems like this one, accurate sensor data 

is crucial since inaccurate readings may cause false alarms or delayed reactions. 

The system demonstrated exceptional responsiveness with respect to alert latency. Alerts were sent to 

the user interface in less than 1.5 seconds when sensor thresholds were crossed, such as when gas was detected 

or the water level overflowed. The system's real-time operational requirements are met by this low-latency 

communication, which guarantees that alarms are received by the appropriate staff members nearly instantly. 

Rapid decision-making and emergency response team deployment are made possible by such timely 

communication. 

Additionally, the system demonstrated excellent network dependability, particularly when addressing 

connectivity problems. During testing, it was found that after an intermittent interruption in connectivity, the 

system could automatically reattach to Wi-Fi networks in about three seconds. This behavior demonstrates how 

well the MQTT communication protocol works to sustain steady data transfer without the need for manual 

reconnections. The ability of the MQTT protocol to withstand brief interruptions guarantees constant data flow 

and monitoring, which is essential for unbroken manhole status monitoring. 

The system's power efficiency was also evaluated. With just one full charge of the inbuilt rechargeable 

battery, it ran constantly for almost forty hours. To keep the power supply steady during the operation, a voltage 

booster circuit was used. The project's design goal of guaranteeing extended field deployment with less need for 

battery replacement or maintenance is met by this longer battery life. Such effectiveness is particularly crucial in 

sites that are difficult to reach or remote, where regular maintenance is not feasible. 

Finally, a Blynk IoT dashboard and a Windows Forms application were used to assess user interface (UI) 

accuracy. With little delay, these interfaces reliably showed real-time sensor data. The user interface's 

responsiveness made it possible for operators to precisely track the state of affairs and base their decisions on the 

most recent data. Effective system operation depends on the user interface's dependability and clarity, particularly 

in emergency situations where every second matters. 

The Manhole Monitoring System performed well overall across all assessed criteria, confirming its 

applicability for monitoring urban infrastructure and emergency management applications in the real world. 

 

Figures  

 
Fig 4.1: User Interface Display for Live Monitoring 

 

The smart manhole monitoring system's default interface is shown in fig 4.1. It shows real-time sensor 

data, such as ultrasonic readings that probably indicate the level of water or an object in the manhole and the 

smell concentration in parts per million (PPM). The monitored access hatch's current GPS coordinates are also 
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displayed on the interface. The MQTT server connection status is represented by a visual plug icon that shows 

whether data is being transmitted by the system. With zero alerts, the green panic indicator appears to be operating 

normally. Operators can use this interface to keep an eye on sewer conditions in real time and start services when 

needed. 

 

 
Fig 4.2: Real-Time Alert System with Panic Indication and GPS Integration 

 

A triggered alert scenario in the smart manhole system is shown in fig 4. 2. The system has activated the 

red panic indicator due to the sensor readings detecting an abnormal smell level (72.76 PPM) and a significant 

ultrasonic value (12.34). When the number of alerts reaches one, the system takes a picture and shows it for visual 

verification. Authorities can locate and evaluate the problem more rapidly thanks to the access hatch's GPS 

coordinates being connected to a map interface. This configuration makes it easier to react quickly to potentially 

dangerous situations like gas accumulation, flooding, or illegal entry. 

 

 
Fig 4.3: Threshold Settings Panel for Sensor Calibration 

 

 
Fig 4.4: Logged Sensor Data Display for Smoke and Gas Levels 
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The smart manhole monitoring system's settings interface for setting threshold values is depicted in fig 

4.3. Two important parameters, "Smell" (indicating gas concentration in parts per million) and "Distance" 

(measured by an ultrasonic sensor, possibly indicating the water or object level inside the manhole), allow the 

user to enter specific limit values. Pressing the "Set" button enables the system to apply the selected thresholds 

for real-time monitoring after they have been entered. This feature aids in adjusting alert sensitivity in accordance 

with safety regulations or environmental conditions.  Fig 4.5: Plot of offset and steering angle vs No of frames 

The logger window in fig 4.4 shows the system's historical data is depicted in this figure. Smoke levels, 

MQ sensor values (which indicate gas concentration), serial numbers (Slno), and the associated timestamps are 

all included. This log makes it possible to monitor environmental conditions over time, which aids in spotting 

patterns, irregularities, or particular occurrences. Additionally, the data can be utilized for reporting, system 

diagnostics, or additional analysis to enhance response and predictive maintenance plans. 

 

V. Conclusion 
An innovative development in the administration of municipal sewage infrastructure, the Internet of 

Things-based Manhole Monitoring System provides a cutting-edge, technologically advanced substitute for 

conventional manual inspection techniques. The system seamlessly combines a full suite of sensors—able to 

detect parameters like tilt, water—to provide municipalities with a reliable, cost-effective, and expandable 

solution for ongoing manhole condition monitoring. levels, gas concentrations, and environmental conditions—

with embedded hardware and real-time communication protocols like MQTT. This creative strategy supports the 

larger goal of smart city development while improving the effectiveness and precision of infrastructure 

management.  

The study has successfully illustrated the viability and useful benefits of implementing IoT technologies 

in actual settings. Important system components have undergone extensive testing in both simulated and actual 

field settings. These include sensor integration, automated data collection, real-time alerting, and data display 

using two platforms (Windows Forms and Blynk). The system's preparedness for urban deployment has been 

strengthened by the demonstration of these components' high effectiveness and functionality. 

Several critical challenges commonly faced by urban sanitation departments are directly addressed by 

the system. First, public safety and environmental health are significantly improved by enabling real-time 

detection of blockages, hazardous gas accumulation, and water overflows, thus minimizing potential risks. 

Second, the automation of monitoring processes greatly reduces the need for frequent manual inspections, thereby 

cutting down on operational costs and labor requirements. Third, the availability of real-time data and alerts 

empowers maintenance teams to respond quickly and efficiently to incidents, enhancing decision-making and 

overall management effectiveness. 

Furthermore, the system's scalable and modular design makes it simple to install in a variety of 

metropolitan areas with little setup work or expense. It is a perfect fit for incorporation into smart city 

infrastructure projects because of its versatility. The system maintains a high degree of energy efficiency and 

operational lifespan by utilizing MQTT over Wi-Fi and low-power sensors, which makes it suitable for long-term 

use in a variety of urban locations. All things considered, the Manhole Monitoring System is a prime example of 

how Internet of Things technology may revolutionize vital public services by providing safer, more intelligent, 

and more sustainable urban infrastructure management. 
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